Tutorial for the PNNL Biodiversity Library Skyline Plugin

Developed By: Michael Degan, Grant Fujimoto, Lillian Ryadinskiy, Samuel H Payne

Contact Information: Samuel Payne (Samuel.Payne@pnnl.gov)

Michael Degan (Michael.Degan@pnnl.gov)

Grant Fujimoto (Grant.Fujimoto@pnnl.gov)

This tutorial is to help users install and use the PNNL Biodiversity Library plugin with Skyline.

Troubleshooting help will follow at the end of the tutorial. We note that this plugin does not work with

Windows XP and must be used with Skyline version 3.1.1.7490 or greater.

Further information about the Biodiversity Library available at:
http://omics.pnl.gov/project-data/biodiversity-library

Installation:
The PNNL Biodiversity Library Plugin for Skyline can be installed through the Skyline tool store interface.
Tools -> Tool Store -> PNNL Biodiversity Library

Running the Plugin:
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The PNNL Biodiversity Library is designed to provide an easy interface for retrieving mass spectrometry data. This data
can be exported into Skyline to assist in SRM assay design or DIA data analysis. The tool exposes peptides identified
in MS/MS by allowing users to select an organism and biological pathway of interest. In total the Biodiversity Library

Select Proteins catalogs M5/MS spectra from 2 million peptides and 200,000 proteins from 118 distinct organisms across the tree of
life. All proteins are cross referenced to KEGG pathways for intuitive biological interpretation. The Library was
by Pathway developed by Sam Payne at Pacific Northwest National Laboratory with data collected over 10+ years in hundreds of

collaborative projects.

Review and
export to Skyline

The wizard helps users browse data using the following steps:
1) Select an Organism.

2) Select pathways on interest.

3) Curate protein identifications.

4) Review and export data to Skyline.

Source: Biodiversity Library v2.1.6 Tuesday, May 19, 2015
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Select an Organism:

You are able to select your desired organisms in one of two ways, either through the Phylogeny Explorer
or by directly searching for the organism by name.

The Phylogeny Explorer organizes organisms through scientific naming convention, i.e. Kingdom,

Phylum, Class and then individual strain of the organism. Human data is additionally broken down by

tissue.

The Organism search (right panel) allows for users to specifically enter a name.

2% PNNL Biodiversity Library

ST~

Select Proteins
by Pathway

Review and
export to Skyline

1) Select an Organism.

Data in the Biodiversity Library is organized bt the organism. To retrieve data, please select an organism of interest. either
through the Phylum/Class explorer or through the Organism search box. If you want to analyze data from multiple
organisms, please export the data one organism at a time.

.
Phylogeny Explorer Organism search
! Archaea X
4 Bacteria Acidiphilium cryptum JF-5 - |
! Acidobacteria Actinosynnema mirum DSM 43827 [
4 Actinobacteria Anabaena variabilis ATCC 29413
Actinobacteria Anaeromyxobacter dehalogenans 2CP-C 2
! Actinobacteridae Anaplasma phagocytophilum HZ |
Coriobacteridae Arthrobacter sp. F824
Bacillus anthracis str. Ames
Gil’dMI’G"ﬂ. Bacillus anthracis str. Sterne W
“ Mygobacterium Bacillus subtilis subsp. subtilis str. 168
obacterium tuberculosis H37Rv Bartonella henselae str. Houston-1
! Alphaproteob a Borrelia burgdorferi B31
Bt g s
! Chl i urkholderia mallei
¢ ghlo::: - Candidatus Chloracidobacterium thermophilum B
j Sk Candidatus Pelagibacter ubique HTCC1062
' Crenarchaeota Caulobacter crescentus C815
| Cyanobacteria Cellulomonas flavigena DSM 20109
| Deinococcus-Thermus Cenarchaeum symbiosum A
! Euryarchaeota Chlorobium tepidum TLS
| Fibrobact /Acidobacteria Group Chloroflexus aurantiacus J-10-fl
> Eiemni - Cryptobacterium curtum DSM 15641
: irmicutes Cyanothece sp. ATCC 51142
' Proteobacteria Cyanothece sp. PCC 7424
| Spirochaetes Cyanothece sp. PCC 7425
| Thermotogae Cyanothece sp. PCC 7822
| Eukaryota Cyanothece sp. PCC 8801
y Cyanothece sp. PCC 8802
Dehalococcoides mecartyi 195
Deinococcus radiodurans R1
Desulfovibrio alaskensis G20 -
n Mmsibrin Ao sms AIN12Y
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Select Pathways of Interest:
After you have selected an organism, you then choose the KEGG pathways you are interested in
investigating within that organism. Alongside the pathway, the coverage metric is dynamically calculated

for each Organism/Pathway combination. You can select as many of these pathways as you desire.
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2) Select pathways of interest.
= Pathway definitions and membership are defined by KEGG. Navigate to pathways and click the checkbox. Multiple
Overview pathways can be selected.
Kegg Pathways Pathways Selected
| « Metabolism & Fructose and mannose metabolism
4 Carbohydrate metabolism

"1 Glycolysis / Gl genesis 100.00% covered in MSMS

:’ Citrate cycle (TCA cycle) 100.00% covered in MSMS

! Pent hosph hway 88.89% covered in MSMS
Pathways

___Pentoseandg ; nterconversions £0.00% covered in MSM!
Ascorbate and aldarate metabolism 75.00% covered in MSMS

Starch and sucrose metabolism 96.00% covered in MSMS

Amino sugar and nucleotide sugar metabolism 92.00% covered in | =
Pyruvate metabolism 96.15% covered in MSMS

Glyoxylate and dicarboxylate metabolism 100.00% covered in MSM
Propanoate metabolism 100.00% covered in MSMS

Butanoate metabolism 100.00% covered in MSMS

C5-Branched dibasic acid metabolism 100.00% covered in MSMS

Select Proteins
by Pathway

! Inositol phosph taboli: 100.00% covered in MSMS
Review and Energy metabolism
export to Skyline Lipid metabolism
‘ Nucleotide metabolism

Amino acid metabolism
Metabolism of other amino acids

! Glycan biosynthesis and metabolism
Metabolism of cofactors and vitamins

' Metabolism of terpenoids and polyketid
Biosynthesis of other secondary metabolites
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Select proteins of interest through KEGG Pathway maps:
The images for the pathways you selected will be created dynamically, highlighting all the KEGG

orthologs for the organism in the pathway. If that ortholog is part of the set of data which has been
observed in the MS/MS space, it will be highlighted initially as red, while if it wasn’t it will be highlighted
blue. From here, you can select the proteins which are of interest to you in the pathway in two ways,
either by clicking on individual ortholog boxes or by clicking the select/deselect all buttons on the right
hand side of the screen. If an ortholog does become deselected it will then be highlighted as grey to
show that the information will not be pushed to the next step of the process.

Additionally, you can save the pathway image by clicking the button on the right-hand side of the
screen, below the Deselect All button. This will save the image for the pathway along with your current
selection of orthologs as a .png file with a resolution of 300 dpi.
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3) Curate protein list for Organism: Mycobacterium tuberculosis H37Rv

Pathways specified in Step 2 are overlaid with proteomics data for the organism selected in step 1. Proteins identified in
the Biodiversity Library are shown in red. Proteins which are annotated in the genome but are not present in the MS data
are shown in blue. Users can deselect any protein they wish to exclude by clicking on the corresponding red box on the
pathway image. (Deselected proteins appear as grey boxes.)

Fructose and mannose metabolism

[ Protein annotated in Mycobacterium tuberculosis H37Rv and observed in M5/MS5 data ~ All Proteins Selected
- Protein annotated in Mycobacterium tuberculosis H37Rv and not observed in M5/MS data
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Fine control of proteins to export:

On the Review and Export tab, the application will display the total number of genes selected for review

from all of your Organism/Pathway combinations of interest as well as an individual breakdown of the
proteins. If there are Organism/Pathway combinations you are no longer interested in, or individual
proteins which you do not wish to export to Skyline, you can prevent these from being exported by

simply unchecking the box for the row(s) you are no longer interested in.

(3 PNNL Biodiversity Library [ESYEN™)
4) Review and export data to Skyline.
4 From this final tab, a table of genes for each organism and pathway are shown for review. By hitting the export button, all
Overview relevant data will be transferred to Skyline. This includes a FASTA file for all selected proteins, as well as the identified
peptides in a bibliospec library.
Organism Pathway # ?
" Mycobacterium tuberculosis H37Rv IFructose and mannose metabolism § |14 vl
Organisms
Pathways B
Organism: Mycobacterium tuberculosis H37Rv
Pathway: Fructose and mannose metabolism
Genes (14)
Select Proteins Export? | Accession R
by Pathway ¥ |Np_214626 | GDP-mannose 4,6-dehydratase
e NO 214827 it sohate aldolase
NP_215615 fructose 1,6-bisphosphatase
Review and |v NP_215954 riosephosphate isomerase
rt to Skvli \iﬁ NP_216027 GDP-D-mannose dehydratase GmdA
v B nucleotide-sugar epimerase Epi
export to Skyline ¥ [ne 216028 dasgar aph EpiA
] NP_216545 6-phosphofructokinase PfkB
|{] YP_177884 ribose-5-phosphate isomerase B
Wl NP_217526 6-phosphofructokinase
v INP_217629 phosphatase
¥ INp 217772 mannose-6-phosphate isomerase
¥ [Np_217774 phosphomannomutase PmmA =
¥ lyp 177951 D-alpha-D-mannose-1-phosphate guanylyitransferase ManB
¥ Inio 21799c nharnhamannamitnacs DmmR '
Select another . Confirm to
Yy < Previous la e




Export data to Skyline:

Once you are satisfied with your selection of combinations and/or proteins, you can then either select

another organism to follow the same workflow, with its own selection of pathways and proteins, or

export the data of interest to Skyline.

Once you confirm the export to skyline, the application will create a FASTA for the proteins you

indicated and download the Spectral Library files for the organisms of interest from the Biodiversity
Library’s Repository on MassIVE (ftp://massive.ucsd.edu/MSV000079053/library/). Once all of the
information is downloaded, it is then imported to Skyline for you to use in your experiments.
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Select Proteins
by Pathway

Review and
export to Skyline

4) Review and export data to Skyline.

From this final tab, a table of genes for each organism and pathway are shown for review. By hitting the export button, all
relevant data will be transferred to Skyline. This includes a FASTA file for all selected proteins, as well as the identified
peptides in a bibliospec library.

Organism Pathway # of Genes Export?
Mycobacterium tuberculosis H37Rv |Frudose and mannose metabolism 114 | )

Organism: Mycobacterium tuberculosis H37Rv

Pathway: Fructose and mannose metabolism

Genes (14)

Export? Accession Protein name

¥ |np_214626 GDP-mannose 4,6-dehydratase
™ NP_214877 fructose-bisphosphate aldolase
¥ [Np_215615 fructose 1,6-bisphosphatase
W |Np_215954 triosephosphate isomerase 5
¥ |Np_216027 GDP-D-mannose dehydratase GmdA
2] NP_216028 nucleotide-sugar epimerase EpiA
¥ |NP_216545 6-phosphofructokinase PfkB
v |yp_177884 ribose-5-phosphate isomerase B
7] NP_217526 6-phosphofructokinase
¥ [Np_217629 phosphatase
¥ [Np 217772 mannose-6-phosphate isomerase
¥ [Np_217774 phosphomannomutase PmmA B
W yp_177951 D-alpha-D-mannose-1-phosphate guanylyltransferase ManB
W Ino 217292 nhacnhansnnnmes #arn DanmB i

Select another . Confirm to
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ftp://massive.ucsd.edu/MSV000079053/library/

View your data in Skyline:

The plugin will automatically propagate the information downloaded into Skyline, where it uses your

peptide settings to create split the proteins imported into peptides and uses the Spectral Library

downloaded through the plugin to perform library matching.
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Troubleshooting

e The application is taking an unusually long time while generating a FASTA from my selection of
proteins.

o Depending on your Skyline settings, Skyline could be seeing that there are proteins
incoming from this FASTA which do not contain peptides according to the current filter
settings. While this window is open from Skyline, our application is waiting for a
response. To allow the information to be fully exported, select “Keep” so that the
proteins will export and the .blib file(s) which download afterwards will provide a library
match and populate the peptides for these new proteins.

e No proteins appeared as red in the KEGG pathway maps.
o This could be due to two possibilities:
= The organism contains proteins which should be observed in MS/MS space on
this pathway, but were not observed in experimental results. These ortholog
boxes will still be highlighted as blue.
= The organism does not contain proteins which should be observed in MS/MS
space on this pathway. In this case, no ortholog boxes will be highlighted on the
image at all.
e Spectral Library doesn’t download.

o Due to the server based location of the Spectral libraries, our application does require a
stable internet connection to acquire these files. If you have confirmed that your
internet connection is stable, the issue is most likely due to the repository on MassIVE
being inaccessible. Please contact either ccms-web@proteomics.ucsd.edu or ccms-
web@cs.ucsd.edu for further assistance with their FTP connection.

e No proteins were downloaded from NCBI.

o Due to the application creating FASTA information dynamically based on protein
selection, our application does require a stable internet connection to acquire these
files from NCBI at runtime. If you have confirmed that your internet connection is stable,
the issue is most likely due to an issue with NCBI’s FTP connection. Please send an email
directly to info@ncbi.nlm.nih.gov for further assistance with their FTP connection.

e My favorite protein was not found or exported to Skyline.
o There are a number of reasons why a specific protein was not pushed into skyline.
= Skyline peptide settings (missed cleavages)
=  Protein not observed in spectral library
=  Protein is not functionally classified by KEGG
o To manually insert new protein:
=  File -> Insert -> FASTA and copy your FASTA snippet in (Skyline will automatically
populate the protein with peptides based on your digestion settings)
= Edit -> Insert -> Proteins and fill out the table.
o To manually insert a peptide go to Edit -> Insert -> Peptides and fill out the table.
o No proteins were imported into Skyline
o This could be due to two possibilities:
= The plugin was unable to obtain FASTA information for all proteins selected for
export. NCBI or your local computer may be experiencing connectivity issues.
= No proteins were selected for export from the plugin. The Spectral Library for
the organism(s) examined still should export, but a message will display
informing you that no proteins were selected and thus no FASTA was created
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Error Messages:
o My version of Skyline is out of date.
=  Qur application requires Skyline to be version 3.1.1.7490 or later. To update to
the most recent version, please go to Skyline Daily's webpage to download the
latest version of Skyline.
o Unable to establish connection to NCBI to acquire FASTA for your organisms.
= The plugin querys NCBI in real time and requires a stable internet connection.
NCBI or your local computer may be experiencing connectivity issues.
o MassIVE Server Unreachable
= The plugin downloads the spectral library files from the UCSD MassIVE FTP
server and requires a stable internet connection. MassIVE or your local
computer may be experiencing connectivity issues.
How do | add my data to the Biodiversity Library?
o The Biodiversity Library is curated by Samuel Payne at Pacific Northwest National
Laboratory. For more information about your data being visible in the Library, please
contact Samuel.Payne@pnnl.gov.
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